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Preface 

This User Guide is been implemented by Boot & Work, S.L. working 

under the name Industrial Shields.  

Purpose of the manual 

The information contained in this manual can be used as a reference to operating, to 
functions, and to the technical data of the signal modules, power supply modules and 
interface modules.  

 

Intended Audience 

This User Guide is intended for the following audience: 

¶ Persons in charge of introducing automation devices. 

¶ Persons who design automation systems. 

¶ Persons who install or connect automation devices. 

¶ Persons who manage working automation installation. 

 

 

   Warnings: 

 

¶ Unused pins should not be connected. Ignoring the directive may damage the 

controller. 

¶ Improper use of this product may severely damage the controller. 

¶ Refer to the controllerΩs User Guide regarding wiring considerations. 

¶ Before using this product, it is the responsibility of the user to read the productΩs User 

Guide and all accompanying documentation. 

¶ Maintenance must be performed by qualified personnel familiarized with the 

construction, operation, and hazards involved with the control.  

¶  Maintenance should be performed with the control out of operation and 

disconnected from all sources of power.  

¶ Care should be taken when servicing electrostatic sensitive components. The 

manufacturer's recommendations for these components should be followed.  

¶ The Ardbox Family PLCs are Open Type Controllers. It is required that you install the 

Ardbox PLC in a housing, cabinet, or electric control room. Entry to the housing, 

cabinet, or electric control room should be limited to authorized personnel. Failure to 

follow these installation requirements could result in severe personal injury and/or 

property damage. Always follow these requirements when Ardbox family PLCs. 
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¶ In case of installation or maintenance of the Ardbox please follow the instructions 

marked in the Installation and Maintenance section. 

¶ Do not disconnect equipment when a flammable or combustible atmosphere is 

present. Disconnection of equipment when a flammable or combustible atmosphere is 

present may cause a fire or explosion which could result in death, serious injury and/or 

property damage. 

 

 

   Avertissements: 

 

¶ Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut 

endommager le contrôleur. 

¶ Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur. 

¶ Reportez-vous au Guide de lΩutilisateur du contrôleur pour les considérations de 

câblage. 

¶ Avant dΩutiliser ce produit, il incombe à lΩutilisateur de lire le Guide de lΩutilisateur du 

produit et la documentation qui lΩaccompagne. 

¶ La maintenance doit être effectuée par personnel qualifié familiarisé avec la 

fabrication, le fonctionnement et les dangers liés au contrôleur. 

¶ La maintenance doit être effectuée avec lΩŞquipement hors service et déconnectée de 

toutes les sources d'alimentation. 

¶ Faites attention lors de l'entretien des composants sensibles à l'électricité statique. 

Les recommandations du fabricant pour ces composants doivent être suivies. 

¶ Les automates de la famille Ardbox sont des contrôleurs de type ouvert. Il est 

nécessaire d'installer l'automate Ardbox dans un boîtier, une armoire ou une salle de 

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande 

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences 

d'installation peut entraîner des blessures graves et/ou des dommages matériels 

importants. Respectez toujours ces exigences lors de l'installation des automates de la 

famille Ardbox. 

¶ En cas d'installation ou de maintenance du Ardbox, veuillez suivre les instructions 

indiquées dans la section Installation et Maintenance. 

¶ Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou 

combustible. La déconnexion de l'équipement en présence d'une atmosphère 

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant 

entraîner la mort, des blessures graves et/ou des dommages matériels. 
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Application Considerations and Warranty 

Read and Understand this Manual 

Please read and understand this manual before using the product. Please consult your 

comments or questions to Industrial Shields before using the product. 

 

Application Consideration                               

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. 

THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR 

PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE 

NOT RATED OR DESSIGNED FOR SUCH PURPOSES.  

Please know and observe all prohibitions of use applicable to the products.  

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY 

WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED 

TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.  

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE 

PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE 

OVERALL EQUIPMENT OR SYSTEM.  

Industrial Shields shall not be responsible for conformity with any codes, regulations or 

standards that apply to the combination of products in the customerôs application or use 

of the product. 

The following are some examples of applications for which particular attention must be  

given. This is not intended to be an exhaustive list of all possible uses of the products, 

nor is it intended to imply that the uses may be suitable for the products: 

¶ Systems, machines, and equipment that could present a risk to life or property. 

¶ Nuclear energy control systems, combustion systems, railroad systems, 

aviation systems, medical equipment, amusement machines, vehicles, safety 

equipment, and installation subject to separate industry or government 

regulations. 

¶ Outdoor use, uses involving potential chemical contamination or electrical 

interference, or conditions or uses not described in this document. 

 

At the customerôs request, INDUSTRIAL SHIELDS will provide applicable third party 

certification documents identifying ratings and limitations of use that apply to the 

products. This information by itself is not sufficient for a complete determination of the 

suitability of the products in combination with the system, machine, end product, or 

other application or use. 
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Intended use or of Industrial Shields products                                                  

Consider the following: 

Industrial Shields products should only be used for the cases of application foreseen in 

the catalogue and the associated technical documentation. If third-party products and 

components are used, they must have been recommended or approved by Industrial 

Shields.  

The correct and safe operation of the products requires that your transport, storage, 

installation, assembly, operation and maintenance have been carried out in a correct It 

must respect the permissible ambient conditions. You should also follow the indications 

and warnings that appear in the associated documentation. 

The product / system dealt with in this documentation should only be handled or 

manipulated by qualified personnel for the task entrusted and observing what is 

indicated in the documentation corresponding to it, particularly the safety instructions 

and warnings included in it. Due to their training and experience, qualified personnel 

are in a position to recognize risks resulting from the handling or manipulation of such 

products / systems and to avoid possible hazards. 

Disclaimers             

Weights and Dimensions 

Dimensions and weights are nominal and they are not used for manufacturing 

purposes, even when tolerances are shown. 

Performance Data 

The performance data given in this manual is provided as a guide for the user in 

determining suitability and does not constitute a warranty. It may represent the result of 

INDUSTRIAL SHIELDSôs test conditions, and the users most correlate it to actual 

application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS 

Warranty and Limitations of Liability. 

Change in Specifications 

Product specifications and accessories may be changed at any time based on 

improvements and other reasons. 

It is our practice to change model numbers when features are changed, or published 

ratings or when significant construction changes are made. However, some 

specifications of the products may be changed without any notice. When in doubt, 

special numbers may be assigned to fix or stablish key specifications for your 

application on your request. Please consult with your INDUSTRIAL SHIELDS 

representative at any time to confirm actual specifications of purchased products. 

 



Ref. 007001001300                Rev. 0: 26-08-2019       

7 
 

 

 

Errors and Omissions 

The information in this document has been carefully checked and is believed to be 

accurate; however, no responsibility is assumed for clerical, typographical, or 

proofreading errors, or omissions.isks 

The control and drive components of an Industrial Shields PLC are approved for 

industrial and commercial use in industrial line supplies. Their use in public line 

supplies requires a different configuration and/or additional measures. These 

components may only be operated in closed housings or in higher-level control 

cabinets with protective covers that are closed, and when all of the protective devices 

are used. These components may only be handled by qualified and trained technical 

personnel who are knowledgeable and observe all of the safety information and 

instructions on the components and in the associated technical user documentation. 

When carrying out a risk assessment of a machine in accordance with the EU 

Machinery Directive, the machine manufacturer must consider the following residual 

risks associated with the control and drive components of a PDS.  

1. Unintentional movements of driven machine components during commissioning, 

operation, maintenance, and repairs caused by, for example: ī Hardware defects 

and/or software errors in the sensors, controllers, actuators, and connection technology 

ī Response times of the controller and drive ī Operating and/or ambient conditions not 

within the scope of the specification ī Condensation / conductive contamination ī 

Parameterization, programming, cabling, and installation errors ī Use of radio devices / 

cellular phones in the immediate vicinity of the controller ī External influences / 

damage.  

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, 

for example: ī Component malfunctions ī Software errors ī Operating and/or 

ambient conditions not within the scope of the specification ī External 

influences / damage. 

3. Hazardous shock voltages caused by, for example: ī Component malfunctions ī 

Influence of electrostatic charging ī Induction of voltages in moving motors ī Operating 

and/or ambient conditions not within the scope of the specification ī Condensation / 

conductive contamination ī External influences / damage  

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose 

a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are 

too close.  

5. Release of environmental pollutants or emissions as a result of improper operation 

of the system and/or failure to dispose of components safely and correctly. 
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Warranty and Limitations of Liability 

Warranty 

Industrial Shieldsôs exclusive warranty is that the products are free from defects in 

materials and workmanship for a period of one year (or other period if specified) from 

date of sale by Industrial Shields. 

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, 

EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-

INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS. 

ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE 

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE 

REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS 

ALL OTHER WARRANTIES, EXPRESS OR IMPLIED 

 

Limitations of Liability  

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, 

OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN 

ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS 

BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY. 

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY, 

REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL 

SHIELDSôS ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY 

HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO 

CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR 

REPAIR. 
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1. Ardbox Relay HF w/ WiFi & BLE : General Features 

 

COMPACT PLC ARDUINO ARDBOX 20I/Os  
RELAY HF 

 

Input Voltage 
 

12 to 24Vdc 
 

Fuse protection (2.5A) 
Polarity protection 

 

Input rated voltage 
 

24 Vdc 
 

 

Rated Power 30 W  

I Max.  1,5A  

Size 100x45x115  

Clock Speed 16MHz  

Flash Memory 
32KB of which 4KB are used by 

bootloader 
 

SRAM 2.5KB  

EEPROM 1KB  

Communications 
I2C -- USB -- RS232 -- RS485 -- 

SPI -- TTL ï WiFi ï BLE   
RS485  

TOTAL Input points 10  

TOTAL Output points 10  

An/Dig Input 10bit 

(0-10Vcc) 

 
0 to 10Vac 

Input Impedance: 39K 
Separated PCB ground 
Rated Voltage: 10Vac 

 
7 to 24Vdc 

I min: 2 to 12 mA 
Galvanic Isolation 

         Rated Voltage: 24 Vdc 
 

  

 

* Interrupt isolated Input 
HS 

(24Vcc) 

7 to 24Vdc 
I min: 2 to 12 mA 
Galvanic Isolation 

Rated Voltage: 24Vdc 

 
7 to 24Vdc 

I min: 3/6 mA 
Separated PCB ground 

 

Analog Output 8bit 
(0-10Vcc) 

0 to 10Vac 
I max: 20 mA 

Separated PCB ground 
Rated Voltage: 10Vac 
 
 

 

Digital Isolated Output 
(24Vcc) 

5 to 24Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay 

Rated Voltage: 24Vdc 
 
 

Imax 24Vdc: 410 mA 

PWM Isolated Output 
8bit (24Vcc) 

5 to 24Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay 

Rated Voltage: 24Vdc 
 

PWM Isolated 
Output 8bit (24Vcc) 

Digital Isolated Output 
Relay 

220V Vdc 
I max: 5A 

Galvanic Isolation 
Diode protected for Relay 
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Expandability 
I2C ï RS232 ï RS485 ï SPI ï TTL  

ï WiFi ï BLE   
 

Reference 
007001001200 
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2. Technical Specifications  

 General Specifications: 2.1

Power supply 
voltage 

DC power supply    12 to 24Vdc   

Operating 
voltage range 

DC power supply 11.4 to 25.4Vdc  

Power 
consumption 

DC power supply 30VAC max. 

External 
power supply 

Power supply voltage 24Vdc  

Power supply output 
capacity 

700 mA 

Insulation resistance 
20MÝ min. at 500Vdc between the AC terminals and the protective ground 
terminal. 

Dielectric strength 
2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA 
max. Between all the external AC terminals and the protective earth 
terminal. 

Shock resistance 80m/s
2
 in the X, Y and Z direction 2 times each. 

Ambient temperature (operating) 0º to 60ºC 

Ambient humidity (operating) 10% to 90% (no condensation) 

Ambient environment (operating) With no corrosive gas 

Ambient temperature (storage) -20º to 60ºC 

Power supply holding time 2ms min. 

Weight 
350g max. 

 

 

 Performance Specification: 2.2

Arduino Board ARDUINO LEONARDO 

Control method Stored program method 

I/O control method Combination of the cyclic scan and immediate refresh processing methods. 

Programming language 
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform 
composed of a programming language. ñsimilar to the Cò. 
http://arduino.cc/en/Tutorial/HomePage 

Microcontroller ATmega32u4 

Flash Memory 32KB of which 4KB are used by bootloader 

Program capacity (SRAM) 2.5KB 

EEPROM 1KB 

http://arduino.cc/en/Tutorial/HomePage
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Clock Speed 16MHz 

 Symbology 2.3

Table that includes all the symbology that is used in the serigraph of the Ardbox Relay WiFi & 

BLE: 

Symbol 
 

Standard No. / 
Standard Title 

 

Standard 
Reference No. / 

Symbol Title 
Symbol Meaning 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

5031 / Direct 
Current 

Indicates that the equipment is 
suitable for direct current only; 
to identify relevant terminals 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

 

5032 / Alternating 
Current 

Indicates that the equipment is 
suitable for alternating current 

only; to identify relevant 
terminals 

 

 
IEC 60417 / 

Graphical symbols 
for use on 
equipment 

 

5130 / Pulse 
General 

To identify the control by 
which a pulse is started. 

 

 IEC 60417 / 
Graphical symbols 

for use on 
equipment 

 

5017 / Earth, 
Ground 

To identify an earth (ground) 
terminal in cases where 

neither the symbol 5018 nor 
5019 is explicily required. 

 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

 

5115 / SIgnal lamp 

To identify the switch by 
means of which the signal 

lamp(s) is (are) switched on or 
off. 

 

Medical Devices 
Directive 

93/42/EEC 
CE Marking 

CE marking indicates that a 
product complies with 

applicable European Union 
regulations 

 
 

ISO 7000/ 
Graphical symbols 

for use on 
equipment 

 

0434B / 
Warning symbol 

Indicates a potentially 
hazardous situation which, if 
not avoided, could result in 

death or serious injury 

 
ISO 7000/ 

Graphical symbols 
for use on 
equipment 

 

5036 / Dangerous 
Voltage 

To indicate hazards arising 
from dangerous voltages 
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3. Precautions  

Read this manual before attempting to use the ARDBOX 20 I/Os Relay HF WIFI & BLE and 
follow its descriptions for reference during operation. 

 Arduino Board 3.1

The ARDBOX 20 I/Os Relay HF WIFI & BLE PLCs include Arduino Leonardo Board as controller.  

 Intended Audience 3.2

This manual is intended for technicians, which must have knowledge on electrical systems. 

 General Precautions 3.3

The user must operate Ardbox according to the performance specifications described in this 

manual. 

Before using ARDBOX 20 I/Os Relay HF WIFI & BLE under different conditions from what has 

been specified in this manual or integrating ARDBOX 20 I/Os Relay HF WIFI & BLE  to nuclear 

control systems, railroad systems, aviation systems, vehicles, combustion systems, medical 

equipment, amusement machines, safety equipment and other systems, machines, and 

equipment that may have a serious influence on lives and property if used improperly, consult 

your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance 

characteristics of Ardbox are sufficient for the systems, machines, and equipment, and be sure 

to provide the systems, machines, and equipment double safety mechanisms. This manual 

provides information for programming and operating the Ardbox.  

4. Software interface  

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C 

language. They can also be programmed using directly C but it is much easier working with 

Arduino IDE as it provides lots of libraries that helps in the programming.   

Furthermore Industrial Shields provides boards for programming the PLCs much easier. 

Basically it is no needed to define the pins and if that pins are inputs or outputs. Everything is 

set up automatically if using the boards. 

In order to install Industrial Shields boards, these are the steps that must be followed. 

 

Requirements: 

Arduino IDE 1.8.0 or above (better to have always the latest version). 

Steps: 
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1. Open Arduino IDE and go to: άFile -> Preferencesέ located in the top left corner. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. In Additional Boards URLs write the following: 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json 

3. Press OK to save the changes. 

 

4. Go to: Tools -> Board: Χ -> Boards Manager 

 

 

 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json
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5. Search for industrialshields. 

 

 

 

 

 

 

 

 

 

 

 

6. Click install (selecting the latest version). 

 

Following this steps you will be able to use now the Industrial Shields Boards: 

 

 

 

Once it is selected the Ardbox Family or Ardbox WiFi & BLE family an extra option will 

appear on Tools: 
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- Select the correct Ardbox WiFi Board (Ardbox Relay  HF+ w/HW RS-232 WiFi/BT or 
Ardbox Relay HF+ w/HW RS-485 WiFi/BT) depending on your jumpers & switch 
configuration.  

 

Also there are some examples of programming in File -> Examples -> Ardbox Family. 

Furthermore there are some extra libraries that can be found in Industrial Shields github. 

https://github.com/IndustrialShields/ 

 

 

5. How to connect PLC Arduino to PC 

 

- Connect USB port from PLC to PC. 

NOTE:  
Ardbox Family uses micro USB cable.  
 
 
 

- Open Arduino IDE interface: 
- Select Industrial Shields boards -> Ardbox Family 

 
 
 
 
 
 
 
 

https://github.com/IndustrialShields/
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- Select correct port. 

 

 

 

 

 

 

 

 

 

6. How to connect PLC to power supply  

- Ardbox Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT 

REVERSAL!  

- Make sure that the live and GND connector of the power supply match the PLC. 

- Make sure that the power supply mains output is not higher than 24Vdc. 
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- Suggested power suppliers  

 

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types 

of electrical devices and their accessories, regardless of where use of the device is intended.  

The equipment must be powered from an external power source in accordance with IEC 

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-

1. 

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of 

the equipment must be separated from the dangerous voltage cables. 

 

 

 

 

 

 

 

 

 

 

 

 

Compact DIN rail power supply. Assembled on 35mm 

DIN Rail: 

-12Vdc / 24Vdc 

-2.5A 

-30W 

 

Industrial Shields power supplies provide parallel 

operation, overvoltage protection, and overcurrent 

protection. There is a LED inductor for power status, 

the power supply is certified according to UL. 
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7. Ardbox Relay w/WiFi & BLE  I/ O pinout:  

 Zone Connections 7.1

 

 

 

 

 

 

 

 

 

 

 

 

 

1
 See section 8 to enable these connections

 

2
 See section 9 to enable these connections 

 

 

 

 

 

 

 

 

 

 

 

 
Base 

(common unit) 
 

 

 
LEFT ZONE 
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R
S
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R
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MISO 
MOSI 
SCK 

RESET 
5VdC 
GND 

RX-RS-232
1,2

 
TX-RS-232

1,2
 

SDA-RST WiFi
1
 

SCL-PIN3
1
 

R1 
R2  
R3 

GND 
24V 

WIF
I 

WIF
I 

15 
- 
- 
- 
0 
1 
2 
3 

10 
9 
6 
- 
- 

WIFI 
WIFI 
15 
- 
- 
- 
8 
4 
2 
3 
10 
9 

6 
- 
- 

SPI-MISO 
SPI-MOSI 

SPI-CLOCK 
SPI-RESET 
5V Output 

GND 
Serial/RS232  
Serial/RS232 
RESET WIFI 
I2C/SPI SS 
Relay 1 Out 
Relay 2 Out 
Relay 3 Out 

GND 
- 

LEFT ZONE 
 
 
 
 
Switch config*  
(see section 8 for Communications  
configuration. Enabling Communications  
disables some  I/Os) 
  

 

 

 

Communications pins 
 

 

 

Relay Outputs 

 
 
 
Power supply connectors  
(24Vdc ς GND) 
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HS*: Hardware Serial 
SS*: Software Serial 
 

1  See section 8 to enable these connections 
2  See section 9 to enable these connections 

 

NOTE: Although in the serigraphy it is not shown the RS232 communication pins, in the reality 

it exists. The change that has to be done is the following: 

DEFAULT SERIGRAPHY CORRECT SERIGRAPHY 

SDA-PIN2 SDA-PIN2 

NC TX-RS232 

NC RX-RS232 

GND GND 

 

 
Base 

(common unit) 
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R
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19 
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8 

4 

12 

2 
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0 
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RS485 

RS485 

RS485/Analog Output 

RS485/Analog Output 

Relay 4 Out 

Relay 5 Out 

Analog/Digital Input 

Analog/Digital Input 

Analog/Digital Input 

Analog/Digital Input 

Analog/Digital Input 

Analog/Digital Input 

Digital Input 

Digital Input 

Digital Input 

Digital Input/  Interrupt 

Relay 6 Out 

Relay 7 Out 

Relay 8 Out 

RIGHT ZONE 
 
 
RS-485 pins 
Analog Outputs Pins 
 
 
 
Relay Outputs 
  
  

 

Digital/Analog Inputs pins 

 

 

Relay Outputs 
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NOTE: Although in the TOP ZONE serigraphy it is shown Q0.9 & Q0.8 pins, in the reality they 

are I0.3 I0.2 pins respectively. Additionally although the serigraphy only is expressed for the 

RS485 it is also the same for the RS232. So if it is desired to enable any of the Hardware Serial 

connection this is the function of these switches. See chapter 8 for more information 

  

 

 

 

 

 

 

 

 

 

 

 

I0.3 RS485/RS232 HS I0.2 RS485/RS232 HS 

                                                               Input / Output              Power LED          Arduino Reset  

                                                                                                                      button 

                                                                          

                 

 

Config switch *  
(see section 8 for communications 
configuration) 
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8. Switch configuration  

 General Switches Configuration 8.1

LEFT ZONE.  
Communications and inputs/outputs can not work simultaneously.  
 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

1. NC ς Not Connected 
 

2. H/F ς Choosing between Half/Full Duplex for the RS485 communication. In order to use Full 
Duplex, it has to be considered the TOP ZONE and the JUMPER ZONE(*see section 9). 

3. SCL/R5 ς Choosing between SCL (I2C) and R5. If the switch is ON, the R5 will be enabled and the 
SCL will be disabled. If the switch is OFF, SCL will be now enabled and R5 disabled. 

4. SDA/I0.0 - Choosing between SDA (I2C) and I0.0. If the switch is ON, the I0.0 will be enabled 
and the SDA will be disabled. If the switch is OFF, SDA will be now enabled and R5 disabled. 

 

1. RE-RS485 ς If this switch is ON, the I0.4 switch must be set to OFF. Being in ON mode it enables 

RE for the RS-485. 

2. I0.4 ς If this switch is ON, the RE-RS485 switch must be set to OFF. Being in ON mode it enables 

the input I0.4. 

3. DE-RS485 ς If this switch is ON, the I0.5 switch must be set to OFF. Being in ON mode it 

enables DE for the RS-485. 

4. I0.5 ς If this switch is ON, the DE-RS485 switch must be set to OFF. Being in ON mode it 

enables the input I0.5. 
 

 
TOP ZONE.  
 
 
 
 
 
 
 
 
 
 
 
Communications and outputs can not work simultaneously.  
 

LEFT ZONE 

SWITCH ON OFF 

NC - - 

H/F Half Duplex Full Duplex 

SCL/R5 R5 SCL 

SDA/I0.0 I0.0 SDA 

RE-RS485 RE-RS485 I0.4 

I0.4 I0.4 RE-RS485 

DE-RS485 DE-RS485 I0.5 

I0.5 I0.5 DE-RS485 

TOP ZONE 

SWITCH ON OFF 

D1 - RS-485 RS-232/485 R8 

R8 R8 RS-232/485 

D0 - RS-485 RS-232/485 R7 

R7 R7 RS-232/485 
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1. D1 ς RS-485: If this switch is ON, the R8 switch must be set to OFF. Being in ON mode it 
enables DI for the RS-485 and RS-232 Hardware Serial ( see section 9 for jumper 
configuration) 

2. R8: If this switch is ON, the DI ς RS-485 switch must be set to OFF. Being in ON mode it 
enables the Relay 8. 

3. D0 ς RS-485: If this switch is ON, the R7 switch must be set to OFF. Being in ON mode it 
enables D0 for the RS-485 or RS-232 Hardware Serial ( see section 9 for jumper 
configuration) 

4. R7: If this switch is ON, the D0 ς RS-485 switch must be set to OFF. Being in ON mode it 
enables the Relay 7. 
 

 
 

 RS- 485 Switch configuration 8.2

 

RS-485 TOP ZONE: In order to enable the RS-485 protocol the 

TOP ZONE must be configured as it is shown in the table. 

Although the switch name is only referenced to RS-485 it is 

also the same for the RS-232.  

Having this setup, the R7 & R8 are disabled. 

 
 

 
 

RS-485 LEFT ZONE: The H/F can be set up as ON or OFF. If it is wished 

to use the RS-485 Half Duplex (A+, B-) it has to be ON. For using the 

RS-485 Full Duplex (A+, B-, Y+, Z-) it has to be OFF.  

The switch RE-RS485 and DE-RS485 must be set in ON mode. As 

these pins are set to ON, the other 2 (I0.4, I0.5) must be set to OFF. 

Being in OFF mode they are completely disabled. 

The switches marked as ά ς ά donΩt interfere with the RS-485 

communication protocol. 

 

 
 
* To enable the RS-485 communication it is needed to configure also the jumpers, see Section 9 

 
 
 
 
 
 
 
 
 

 
TOP ZONE 

SWITCH MODE 

DI - RS-485 ON 

R8 OFF 

D0 - RS-485 ON 

R7 OFF 

LEFT ZONE 

SWITCH MODE 

NC - 

H/F ON/OFF 

SCL/R5 - 

SDA/I0.0 - 

RE-RS485 ON 

I0.4 OFF 

DE-RS485 ON 

I0.5 OFF 
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 RS- 232 Switch configuration 8.3

 

RS-232 TOP ZONE: In order to enable the RS-232 protocol the 

TOP ZONE must be configured as it is shown in the table. 

Although the switch name only is referenced to RS-485 it is 

also the same for the RS-232.  

Having this set up, the R7 & R8 are disabled. 

 
 

 
 

RS-232 LEFT ZONE: As both RS-232 & RS-485 canΩt work at the same 

time, the RE-RS485 and DE-RS485 have to be in OFF mode, so this 

enables the I0.4, I0.5 inputs.  

 

 
 
 
 
 
 
 

 
* To enable the RS-232 communication it is needed to configure also the jumpers, see Section 9 
 
 

 I2C Switch configuration 8.4

 

 
 

 

 

 

 

 

 

To enable I2C configuration the switches SCL/R5 & SDA/I0.0 must be set to ON. As they are in 

ON mode R5 & I0.0 are disabled. 

The switches marked as ά ς ά donΩt interfere with the I2C communication protocol. 

 
TOP ZONE 

SWITCH MODE 

DI - RS-485 ON 

R8 OFF 

DO - RS-485 ON 

R7 OFF 

LEFT ZONE 

SWITCH MODE 

NC - 

H/F - 

SCL/R5 - 

SDA/I0.0 - 

RE-RS485 OFF 

I0.4 ON 

DE-RS485 OFF 

I0.5 ON 

 
TOP ZONE 

SWITCH MODE 

DI - RS-485 - 

R8 - 

DO - RS-485 - 

R7 - 

LEFT ZONE 

SWITCH MODE 

NC - 

H/F - 

SCL/R5 ON 

SDA/I0.0 ON 

RE-RS485 - 

I0.4 - 

DE-RS485 - 

I0.5 - 
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9. Jumper Configuration  

General jumper configuration 

 
This jumper zone makes the selection between using the RS-485 Full 
Duplex or the Analog Outputs. If it is wanted to use the RS-485 Full 
Duplex communication protocol the Y+ must be connected to ENABLE, 
and Z- also connected to ENABLE. If it is wanted to use the Analog 
Outputs, The A0.0 must be connected to ENABLE, and A0.1 also 
connected to Enable  
 
This jumper zone makes the choosing between connecting the inputs 
I0.2, I0.3 to pins 4 and 8 of the Arduino Leonardo respectively, or 
connect the RS-232 ports to activate the Software Serial RS-232. In 
order to use the inputs I0.2,I0.3 the jumper must be connected to the 
pins 4 and 8. So I0.2 must be connected with D4 and I0.3 must be 
connected to D8. 
 

 
This jumper makes the choosing between connecting MAX232 to pins 
0,1 of the Arduino Leonardo or with the MAX485. In order to use the 
RS-232 Hardware Serial protocol both RS-232 must be connected to 
the D1/D0. In order to use the RS-485 Hardware Serial protocol both   

             RS-485 must be connected to the D1/D0. 
 
*The jumpers that are not connected to the middle jumpers MUST NOT be connected anywhere.  
 

 
 

JUMPER ZONE 1 

 LEFT RIGHT 

Y+ Z- 

ENABLE ENABLE 

A0.0 A0.1 

JUMPER ZONE 2 

 LEFT RIGHT 

I0.2 I0.3 

D4 D8 

RS-232 RS-232 

JUMPER ZONE 3 

UP RS-485 D1 RS-232 

DOWN RS-485 D0 RS-232 
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10. Hardware Serial RS-232 & RS-485 Configuration  

 Hardware Serial RS-232 10.1

In order to enable the Hardware Serial RS-232 the total configuration of the Ardbox Relay HF 

will be: 

Switch configuration: 

 

 

 

 

 

 

 

Jumper configuration:  

 

  

 

 

Having configured Ardbox Relay HF as it is shown above, these are the features that are 

available: 

o Available communication protocols: 

¶ Hardware Serial RS-232. 

¶ I2C  *If I2C is active R5 & I0.0 are disabled 

¶ SPI 

¶ TTL 

¶ USB 

 

o Inputs: All 10 inputs, from I0.0 to I0.9. If using I2C I0.0 is disabled 

o Relay Outputs: From R1 to R6. If using I2C R5 is disabled. R7 and R8 are disabled from 

the TOP ZONE switch. 

o Analog Outputs: A0.0 & A0.1 

 

 

LEFT ZONE 

SWITCH MODE 

NC - 

H/F - 

SCL/R5 - 

SDA/I0.0 - 

RE-RS485 OFF 

I0.4 ON 

DE-RS485 OFF 

I0.5 ON 

 
TOP ZONE 

SWITCH MODE 

DI - RS-485 ON 

R8 OFF 

DO - RS-485 ON 

R7 OFF 

JUMPER ZONE 1 

 LEFT RIGHT 

NC NC 

ENABLE ENABLE 

A0.0 A0.1 

JUMPER ZONE 2 

 LEFT RIGHT 

I0.2 I0.3 

D4 D8 

NC NC 

JUMPER ZONE 3 

UP NC 
D1 

 

RS-232 
 

DOWN NC 
 

D0 
 

RS-232 
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 Hardware Serial RS-485 10.2

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Relay HF 

will be: 

Switch configuration: 

 

 

 

 

 

 

Jumper configuration:  

 

  

 

 

Having configured Ardbox Relay HF as it is shown above, these 

are the features that are available: 

 

 

 

 

o Available communication protocols: 

¶ Hardware Serial RS-485. 

¶ I2C  *If I2C is actived R5 & I0.0 are disabled 

¶ SPI 

¶ TTL 

¶ USB 

 

o Inputs: All 10 inputs except for input I0.4, I0.5 as they are disabled from the LEFT ZONE 

switch. If using I2C I0.0 is disabled 

o Relay Outputs: From R1 to R6. If using I2C R5 is disabled. R7 and R8 are disabled from 

the TOP ZONE switch. 

o Analog Outputs: A0.0 & A0.1 if RS-485 is working in Half Duplex. They are disabled if 

using RS-485 Full Duplex, see the JUMPER ZONE 1 from above. 

LEFT ZONE 

SWITCH MODE 

NC - 

H/F ON/OFF 

SCL/R5 - 

SDA/I0.0 - 

RE-RS485 ON 

I0.4 OFF 

DE-RS485 ON 

I0.5 OFF 

 
TOP ZONE 

SWITCH MODE 

DI - RS-485 ON 

R8 OFF 

DO - RS-485 ON 

R7 OFF 

JUMPER ZONE 1 HALF DUPLEX 

 LEFT RIGHT 

Y+ Z- 

ENABLE ENABLE 

A0.0 A0.1 

JUMPER ZONE 2 

 LEFT RIGHT 

I0.2 I0.3 

D4 D8 

NC NC 

JUMPER ZONE 3 

UP 
RS485 D1 

 
 

NC 
 

DOWN 
 

RS485 
 

D0 
NC 

JUMPER ZONE 1 FULL DUPLEX 

 LEFT RIGHT 

Y+ Z- 

ENABLE ENABLE 

A0.0 A0.1 
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11. Ardbox - Arduino  I/Os 5V pins  

The Ardbox has some of the Leonardo board pins available.  These pins can be programmed 

according to Arduino features such as I/Os operating at 5V or any additional features present 

in the pins (for example I2C communication in pins SCL and SDA). As this pins are directly 

connected to the Arduino Leonardo board they are not as well protect as the normal inputs. 

These pins are mainly meant to be used as prototyping. 

 

 

 

 

 

* IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V. 

These terminals provide direct access to the Leonardo board. 

A part from the switch configuration there are some special conditions depending on these 5V. 

Now it is going to be shown the considerations to operate with these pins. 

 

 

 I2C pins ɀ SDA/SCL 11.1

The I2C protocol is meant to work in a pull-up configuration. The I2C pins in the Arduino 

Leonardo are not pull-up, so in order to work with the I2C an external pull-up resistor is 

required. If it is meant to work as a GPIO at 5V, the switches must be set as I2C, (section 8).  

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

 Pin3  11.2

Pin3 is only referred to the input R5. If the switch configuration is in OFF position the pin Pin3 

will be available.  

This pin is not stablished with a pull-up or pull-down configuration.  The state of pin 3 is 

unknown. If using pin3, it requires a pull-up or a pull-down configuration. The Arduino board 

allows pin 3 to be set in a pull-up configuration. If not it must be stablished an external pull-up 

or pull-down circuit in order to correctly work with this pin. 

Ardbox terminal Arduino pin 

SCL ï Pin 3 3 

MISO 14 

SCK 15 

MOSI 16 
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 SPI ɀ MISO/MOSI/SCK 11.3

These pins are used for the WiFi & BLE module. 

These pins are not stablished with a pull-up or a pull-down configuration. The state of these 

pins is unknown. If these pins must be used, they require a pull-up or a pull-down 

configuration. The Arduino board allows the pins to be set in a pull-up configuration. If not it 

must be stablished an external pull-up or pull-down circuit in order to correctly work with 

these pins. 

12. WiFi &  BLE  

 

The WiFi and Bluetooth integrated module consists in a single 2.4 GHz Wi-Fi and Bluetooth 
combo chip designed with the TSMC ultra-low-power 40 nm technology. It is designed to 
achieve the best power and RF performance, showing robustness, versatility and reliability in a 
wide variety of applications and power scenarios. Some applications are Generic Low-power 
IoT Sensor Hub, Generic Low-power IoT Data Loggers and Mesh Network. 
It is designed for Internet-of-Things (IoT) applications.  

 

 General Specifications: 12.1

 

Wi-Fi 
¶ 802.11 b/g/n  
¶ 802.11 n (2.4 GHz), up to 150 Mbps 

Bluetooth 

¶ Bluetooth 4.2 BR/EDR BLE dual mode controller 
¶ +12 dBm transmitting power 
¶ NZIF receiver with -97 dBm BLE sensitivity 

 

 WiFi & Bluetooth Module Configuration 12.2

 

In order to configure the WiFi & BLE module, you must connect it to a PC. 
To connect it you will need a micro USB to USB cable. 
 
The slot for the micro USB input is located on the right side of your equipment. 
 
To load the program into the ESP32 you have to use the apropiate board. For that, update our 
board to the latest version. Go to Tools -> Board -> Boards Manager. Shearch by Industrial 
shields-esp32. 
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Now you are able to install the board. Go to Tools > Boards -> WiFi module.  
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The internal connections between the ESP32 module and the Arduino Leonardo are the 

following: 

 

Ardbox Relay 20 I/Os WiFi & BLE 

Modbus 
ESP32 Pinout 

5Vdc Vcc 

GND GND 

Tx1  TxD 

Rx1  RxD 

 

WiFi and Bluetooth are always enabled as there are no switches that configure it.  

The WiFi and Bluetooth module uses Serial2 for communication. 

More information: https://www.industrialshields.com/blog/industrial-shields-blog-1/post/wifi-
bluetooth-module-esp32-devkit-v1-133 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://www.industrialshields.com/blog/industrial-shields-blog-1/post/wifi-bluetooth-module-esp32-devkit-v1-133
https://www.industrialshields.com/blog/industrial-shields-blog-1/post/wifi-bluetooth-module-esp32-devkit-v1-133
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13. I/0 technical details  

Digital Output Waveform 

 

 

 

 

 

 

 

 

Digital Output Turn-off 
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PWM Waveform 
 

 

 
Analog Out Turn-on 
 

 

 
Analog Out Turn-off 
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Analog/Digital Input Turn-on 
 

 

 
Analog/Digital Input Turn-off 
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14. Typical Connections  
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